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1 INTRODUCTION 

1.1  What’s in This Tutorial 

This tutorial provides instruction on logging in to the AgileAssets Fleet Management System (FMS) and 
performing basic fleet management tasks. It is intended to help the user become familiar with the various 
menu items and functions available. Information is also provided on seeking assistance to resolve 
questions you may have about the features or use of FMS.  

1.2  Conventions Used in This Tutorial 

To assist you in differentiating types of information or actions required of you, this manual uses the 
following typographical conventions: 

> The greater-than sign separates menu levels (for example, File > Open). 

CAPITALS Upper case text indicates the names of keys on the keyboard (for example, SHIFT or 
CTRL or ALT+F4).  

+ When used between keyboard keys, the plus sign indicates keys that must be pressed 
simultaneously to perform a command (for example, ALT+F4). 

Bold Commands are shown in a heavy bold font (for example, Retrieve). 

Tahoma  The Tahoma font is used for text that appears in a window and statements that are to 
be typed in exactly as shown. 

Title Caps Title Capitalization often indicates a specific data element type (for example, Work 
Order, Service Request, Work Function). 

Underline Underlining indicates an agency element description such as a job title or a 
maintenance item.  
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2 HOW TO LOG ON TO THE SYSTEM 

2.1  System Log On 
To launch and log on to FMS, you need the following information: 

 The URL (web address) to access the system. 

 Your user ID. 

 Your user password. 

 The administrative unit to which you are assigned. 

Once you have this information, follow these steps to log on to the system 

1. Launch your Internet browser (Internet Explorer, Firefox, etc…). 

2. In the address window of the browser window, type the URL for where the system resides and 
press Enter. (Note that if this is the first time you are accessing the system, you should save this 
URL as a "favorite" to facilitate return visits.) After the Enter key is pressed, the browser window 
will show the log on window for the system. An example of this window is shown below.  

  

3. In the User ID field, type your user ID. (If you have previously logged onto the system, the 
system will remember your user ID and so you will only need to enter your password.) 

4. Press the Tab key to move the cursor to the User Password field and type your password.  

5. Click Login. The system checks the information you entered and, if recognized, logs you on to the 
system and displays a window to select your administrative unit. An example of this window is 
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shown below.         

 

 

Note:  You are only allowed a specific number of attempts to log on within a certain time period. 
(The System Administrator sets the number of attempts and time period.) After the last 
unsuccessful attempt, you will be locked out of the system. You must contact the System 
Administrator to be allowed to log on to the system. 

6. Click on the down arrow to display the administrative units, locate the desired unit, and then 
click on the desired unit. (Note that if you have previously logged onto the system, the system 
will remember the unit you last used and so you may skip this step.) 

Note:  The selection of an administrative unit is important. At various points in the system, the 
phrase "current unit" appears. The current unit is the unit you selected when you logged on. 

7. Click Submit. You are now fully logged onto the system, and the system displays the main 
window of the application. This window shows all available modules. Click on a module name to 
access the features of that module. 

2.2  Forgotten Password 
FMS provides a Forgotten Password feature that will reset a user’s password to a random string and 
email the temporary password to the user. The following steps explain how to use this feature. 
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1. In order to use this feature, a user must have already picked and answered their security 
question. The first time a user logs in they will be prompted to chose and answer a security 
question. See below for an example of this window. 

 
2. Once the question and answer have been submitted, the user can click the “Forgot your 

password?” link on the login screen. See below for an example. 

 

3. A window will then be displayed prompting the user to submit the user id to be reset. 

 
4. After submitting the user id, the user will then be prompted to answer the security question 

associated with this user id. 

 
5. Once the correct answer has been submitted, the following message is displayed and an email 

sent to the user email address with a temporary password.  
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6. The user can now use the temporary password to login and then will be prompted to change 
their password after successfully logging in. 
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3 MANAGE USER ACCOUNTS 

The User Names and Access window shows all the users and their associated access level in the system 
(all modules). This window is composed of three panes; System Users, Admin. Units Available, and 
Security Profiles. In the System Users pane, users may be added or deleted, and some of their attributes 
may be edited. Columns that may be edited are: the user's parent agency (this column has no bearing on 
what the user may select when logging on; instead the application uses what is configured in the Admin 
Units Available pane), his or her email address, and whether the user is allowed to log on (that is, 
whether the user name is "active").  

A check mark in the Allow Login check box indicates that the user is allowed to log on. If a user enters an 
incorrect password the number of consecutive times set in the System Parameters window, the system 
disables that user's access and clears the Allow Login check box. The Application Administrator can 
restore the user's access by clicking the check box and saving the change. The check box may also be used 
to suspend a user's access privileges. 

A check mark in the Is Admin? check box indicates that the user has design privileges. This means that 
the user is allowed to adjust a window's properties (column widths, sizes and position of panes, labels, 
titles, etc.). This column is editable only by CPA IT Role users and is read only by all other security 
profiles. 

A check mark in the Working Now? column indicates that the user is logged on to the application. 

3.1  List of Security Profiles 

The system is currently providing the following security roles [arranged in the hierarchical order, from 
highest access level (CPA IT) to the lowest access level (View Only)]: 
 

• CPA IT – Manages all software application configuration activities and maintenance 
• CPA System Administrator – Handles all CPA's administration duties such as system front end 

questions and issues, reporting, and primary contact for the agencies,  
• Agency system Administrator – handles all users’ security profiles at the agency level, such as 

add, edit and delete users. In addition has full access to the system.  
• Fleet Manager –Allows full access to the system with exception of system administration and/or 

record deletion function 
• Fleet Specialist – Performs fleet data entry; not allowed to delete records  
• Technician - Equivalent to mechanic in FF;  captures routine work order data and basic 

maintenance records which may include parts inventory control 
• Batch  – for all users who will be processing monthly batch uploads of fuel, meter readings, PM 

work order data, repair work order data, and trips and passengers usage 
• Motorpool - user of the motorpool functionality 
• View Only – For non-fleet managers and executives who need access to data and are able to run 

reports 
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3.2  How to Create a New User 
You may use two methods to add a user to the application. One method is to simply create a new, blank 
record and complete the record as needed. The second method is to create a new record that is largely a 
copy of an existing record, and then modify the record.  

3.2.1 Insert Method 
1. Display the User Names and Access window (System > Utilities > User Names and Access). 

 

2. Right click Insert in the System Users pane. A new window will be displayed. 

 

3. Enter the new user's name and then click the OK button. A message window will notify you that 
the default user password is set to the user's name and that the user should change the password 
when he or she first logs on. (The user changes his or her password using the Change Password 
window in the Utilities Menu available in all modules.) 

4. Click OK to close the message window. The system closes the window and adds a record to the 
System Users pane. 

5. Enter all required information for this user in the System Users pane (top right). 
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6. Select the appropriate security role in the Security Profile pane (bottom pane) by check the box 
for the appropriate role(s). 

 

7. Assign Admin Unit to this user by right click Select This or Select All  or Select Branches in the 
Admin. Units Available pane (right click Deselect This if needed). 

 

8. Click on Save  in the general navigation menu on the far left. 

 

3.2.2 Insert Like 
1. Right click on the user profile you want to duplicate and then select Insert Like in the System 

Users pane. 

 
2. In the new window, enter a user name (the default password will be the user name). Click OK to 

close the message box. The system closes the window and a new row is added to the System 
Users pane. The Security role and the assigned administrative unit will be copied to the new user. 

3. Click on Save  in the general navigation menu. 

 

Note: If you are an Agency System Administrator, you will see the following warning message 
when you will create new users. Click on OK  in the dialog box and proceed normally. 
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3.3  Passwords 
When a new user account is created, the new password defaults to the User ID. After the initial log-on, 
the user may change his or her password at any time by utilizing the Change Password menu item 
found in the Utilities menu of all modules. The user will also need to change his or her password after the 
amount of time since the last change elapses as set by the Life of Password parameter in the System 
Parameters window. The system will prompt the user in this case. 

If the user forgets his or her password, the Application Administrator may utilize the Change Password 
command found in the User Names and Access window. This command is found on the shortcut menu 
that is displayed by right-clicking the user’s record. Alternatively, a user may obtain a new password via 
email using the Forgotten Password feature. 
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4 NAVIGATION 

FMS provides the following ways to navigate to, and within, the windows in the system:  "point & click" 
commands, table navigation via scroll bars and a table navigation toolbar, and Quicklinks (which is a 
special, customizable form of hyperlinks). 

4.1  Menus 

You display a window by selecting a series of commands from menus. For example, to display the 
Material Management window (which is in the Resources module), perform the following steps: 
 

1. Since the default active module is Fleet Management, click Resources to activate the Resources 
module. After selecting this module, the menu bar on the second line of the window changes to 
show the menus of the Resources module. 

2. Click Materials. This displays the submenus of the Materials menu. 

3. Hover over (that is, place the cursor on but do not click) Inventory. This displays the Inventory 
submenu. 

4. Click Material Management. The Material Management window is displayed. 

Graphically, this series of steps appears as shown below. 

 

 

In this FMS tutorial, this entire series of actions is abbreviated as:  "Resources > Materials > Inventory > 
Material Management." 
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4.2  Scroll Bars 

Once a window is displayed, scroll bars are available to move what is viewable either vertically or 
horizontally. Be observant as to which scroll bars you select to use — two sets are provided (depending 
on the size of your browser window): 

 One set is for the browser window, and these move the viewable portion of the entire browser 
window. They do not affect what is viewable within FMS. (These will be absent if the browser 
window is large enough to contain the display presented by FMS.) 

 The second set applies to windows (and panes, which are subdivisions of a window) within 
FMS. These change what is viewable in FMS. 

4.3  Navigation Toolbar 

In addition to scroll bars, tables also provide a navigation toolbar. The tables that are displayed in FMS 
are often quite large. In these large tables, the number of records (rows) is greater than what may be 
displayed at one time in a window or pane. So the table is divided into multiple pages. A navigation 
toolbar similar to the following appears at the top of every table to inform you of the number of pages 
and rows in the table and to allow you to navigate to different pages: 

 

Go back one page. 

Go to first page. 

Go forward one page. 

Go to last page. 

Current page. 

 

You may click the buttons as indicated to navigate to different pages in the table. You may also double-
click the displayed page number, type a new page number, and then click Go (or press Enter on the 
keyboard) to display that particular page.  

Note that the vertical scroll bar that appears along the side of a window that displays a table cannot be 
used to move from page to page. The scroll bar only allows you to change what is viewable for the page 
that is displayed in the window or pane. 

4.4  Quick Links 

Quicklinks provide a handy way to quickly navigate to frequently used windows from a module's main 
menu. These are essentially customizable hyperlinks that remove the necessity of "pointing & clicking" to 
get to a window within the module. (You cannot establish a Quicklink to a window in a different 
module.) 
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For example, say you would like to move quickly to the Material Management window within the 
Resources module. Ordinarily, you would need to perform the series of steps shown on the previous 
page. This involves several "points & clicks." You could shorten this navigational path considerably by 
establishing a Quicklink to the Material Management window as described below: 
 

1. Display the Material Management window (Resources > Materials > Inventory > Material 
Management). 

2. Click Add Window Link .  

 

3. A Quicklink appears in the main window for the Resources module with Material Management 
shown as a hyperlink in the table. Now, whenever you select the Resources module, you may 
simply click this hyperlink to directly display the Material Management window rather than 
"point & click" through the series of menus. 

 

Note that once the Material Management window is configured as a Quicklink, the Delete 

Window Link precedes the hyperlink. This icon allows you to remove the Quicklink to the 
Material Management window. 
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5 HOW TO PERFORM BASIC 

CONFIGURATIONS 

FMS contains a very large amount of information. This is due to the need for the system to cover all 
aspects of your statewide agency. However, much of this information is not needed to perform your daily 
tasks — and, in fact, can actually make your work less efficient because you must sort through a lot of 
information to find just what you need. The system provides several features to ease this difficulty and 
make your work more efficient. 

5.1  Shortlists 
Shortlists are simply lists of just those things (employees, and materials) that you use most frequently. By 
creating a shortened list, the creation of work orders is made easier and more efficient. 

For example, say you are creating a work order. Part of this process is selecting the employee to be used, 
which is accomplished by selecting the name of the employee from a drop-down list. Now if you did not 
have a shortlist, this drop-down list would show all employees in your agency. This is most likely a very 
long list, and locating the desired person could take a long time. However, if you create a shortlist of just 
those employees in your administrative unit that are regularly assigned to work orders, the drop-down 
list will be considerably shorter -- and locating the desired employee will be much quicker and easier.  

Note that shortlists are specific to an administrative unit. Furthermore, when the system displays a 
resource list, it is the resource shortlist that is actually displayed. For example, the list of employees 
displayed in the Day Cards window shows only those employees in your employee shortlist — not all 
employees of your entire agency. 

5.1.1 How to Create Shortlists 
FMS supports several shortlists. The shortlists are all created in a similar way. This section describes how 
to create these shortlists. 

To create an employee shortlist, perform the following steps: 
1. Navigate to the Labor Shortlist window (Fleet Management > Setup/Inventory > Short List… > 

Labor). This window contains a table that appears similar to the example shown below. 
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Note that the information in this table is read-only. You cannot change any displayed 
information, nor can you add (or remove) an employee.  

2. Look at the Select column in the table. A checkmark in the selection box indicates those 
employees that are on your employee shortlist. 

3. Modify the list as needed by checking or clearing the selection boxes. To add an employee to 
your shortlist, click the selection box in the row with the employee's name. To remove an 
employee from your shortlist, click the checkmark shown in the selection box. 

4. When all employees that you wish to appear in your employee shortlist have checkmarks in the 
selection boxes, click Save to store this information. 

 

5.2  Resource Sharing 
When you create a work order, you may only use the resources that belong to your administrative unit. 
However, if an activity required (for example) an employee that was not assigned to your administrative 
unit, you would need to go through the process of temporarily transferring that person to your unit so 
you could use them in a work order. 

This could be a time-consuming chore if you had to perform it often. FMS therefore provides for resource 
sharing. This allows you to specify resources that may be shared among certain administrative units. This 
allows you to include the resources of another administrative unit in your shortlists, which removes the 
need for creating a temporary transfer in FMS in order to assign the resources to a work order. 

5.2.1 How to Share Resources 
In FMS, you may only create work orders using the labor resources that are assigned to your 
administrative unit. Generally, this works fine. Yet, situations may arise where you need to use resources 
assigned to another administrative unit. When these situations occur more than once in a while, it is best 
to share resources between administrative units. This allows you to include the other administrative 
unit's resource in your labor shortlist, which in turn allows you to use its labor in your work orders. 

Note that resource sharing only occurs in one direction. That is, if administrative unit A is allowed to 
share the resources of administrative unit B — administrative unit B is not automatically allowed to share 
the resources of administrative unit A. To allow two-way sharing of resources, each unit must be 
configured to share resources with the other. 
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In the following example, the two subdivisions:  TX A&M University and TX A&M University – 
Kingsville, for reasons of efficiency and workload leveling, Headquarters decides that employees should 
be shared between the two units. To share employees between these two administrative units, perform 
the following steps: 

1. Navigate to the Resource Sharing window (System > Setup > Resource Sharing). (Note that 
due to security restrictions, the average user may not be able to access this window. Instead, the 
System Administrator will need to enable any resource sharing.) An example of this window is 
shown below. 

 

 

2. Expand the hierarchy for the TxFleet - CPA by clicking on the plus sign. The system displays the 
shops under the TxFleet – CPA unit. 

3. Click TX A&M University. This selects this administrative unit. 

4. In the Labor pane on the right side, right-click, and then click Edit Selection from the shortcut 
menu that is displayed. This displays a dialog box from which you may select the administrative 
unit(s) whose resources will be shared with TX A&M University. 
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5. Locate the desired unit. Expand the hierarchy if needed by clicking on the plus sign.  

6. Point to TX A&M University - Kingsville, right-click, and then click Select This. The box is 
highlighted to denote that it is selected. The system displays a dialog box similar to that shown 
below.  

 

7. Click OK. The dialog box closes and TX A&M University - Kingsville appears in the Labor pane. 

8. Click Save  to store the information.  

TX A&M University may now use the labor resources of TX A&M University - Kingsville in its work 
orders (once these resources are included in TX A&M University's labor shortlist). However, TX A&M 
University - Kingsville cannot yet use the equipment and material resources of TX A&M University in its 
work orders. To accomplish this, repeat steps 3 through 8 — switching the specified units. Once these 
steps are performed, the two units may share resources with each other. 
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6 SETUP TABLES 

There are several Setup Tables that will be managed only in FMS. A common command for these tables is 
the Insert command used to add a new value to the list. These fields are available as dropdowns in the 
Equipment Inventory window. 

• Work Action Code 
• Accident Status 
•  Accident Type 
• Accident Claim Type 
• Fuel Product Code 
• Equipment Accessory 
• Disposal Reason 
• Disposal Method 

These tables should only be maintained by a system administrator. 

6.1  Equipment Class Code 
Equipment is classified in a hierarchical arrangement by type. Each type is assigned a code. The Setup 
Equipment Class Codes window is where the hierarchical arrangement is defined and the codes are 
created and maintained. 

The Equipment Class Code window contains two panes:  on the left, a tree view that shows the 
hierarchical arrangement of the codes; and, on the right, a table view that provides information about 
each code. The tree view is expanded by clicking on a plus sign (+), or collapsed by clicking on a minus 
sign (-).  
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7 PREVENTIVE MAINTENANCE 

To maintain vehicles in the best condition possible, it is important that routine maintenance be performed 
at prescribed intervals. (Those intervals may be either time or mileage — for example, oil and filter 
changes should be performed every 6 months or 4,000 miles.) In FMS, this routine maintenance at 
prescribed intervals is termed "preventive maintenance" (PM). 

FMS provides two methods for defining PM:  PM for a class of vehicles and PM for a particular vehicle.  

Unlike the current arrangement of vehicles, vehicles and equipment in FMS are arranged in a class code 
hierarchy, as shown in the following picture: 

 

For example, passenger cars are separated from trailers. These are both classes of equipment. Within each 
class, subclasses can exist as defined by the system administrator. 

A PM schedule is one or more activities performed at certain intervals. When PM is defined for a class of 
vehicles, all types of vehicles within the class and any subclasses follow the same PM schedule. The 
system highlights the box beside the node in the hierarchy that has a PM schedule. All nodes that fall 
below this node follow the same schedule even though they are not highlighted. 

In the example above, all passenger cars follow the same passenger cars PM schedule except compact 
cars. Since compact cars have their own PM schedule, a highlighted box appears beside this node to show 
that they do not follow the passenger cars PM schedule. 

The following sections show you how to create PM schedules for a class of vehicle and for a particular 
vehicle. 
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7.1  How to Create PM for a Class of Vehicles 
As explained in the introduction to this section, PM may be created for a class of equipment — and for all 
subclasses and types of equipment that fall within this class. This section shows you how to create a PM 
schedule for a class of vehicles. In this example, we assume that a passenger cars PM schedule is already 
defined. This PM schedule covers all passenger cars. However, since compact cars require greater care 
and maintenance, a separate PM schedule will be set up for this class of equipment. 

To create a PM schedule for a class of equipment: 
 

1. Display the PM by Class Code window (Fleet Management > Setup/Inventory > Equipment 
Inventory > PM by Class Code). An example of this window is shown below. 

 

2. In the tree view on the left, locate the desired class of equipment. This may require expanding the 
tree view by clicking a plus sign. 

3. Once you locate the desired class of equipment, point to it, right-click, and then click Define Its 

Own PM Setup. The system highlights the box beside the node to show that it now has its own 
PM schedule. Note that the existing PM schedule does not change. 

 



AgileAssets Fleet Management System 
Tutorial 

Page 20  

4. In the right pane, the table shows the PM schedule. Each row of the table is for a different PM 
activity. The PM Trigger and PM Parameters columns indicate when the activity is to be 
performed. When both time and mileage is indicated as the "PM trigger," the first number in the 
PM Parameters column indicates days and the second number indicates miles. In the following 
example, the PM Service A activity is performed every 180 days or 10,000 miles: 

 

Modify the shown PM schedule to create the PM schedule for the desired class of equipment: 

• To remove a row from the table, point to the row, right-click, and then click Delete. 

 

• To insert a row into the table, point to the table, right-click, and then click Insert. The 
system adds a new row at the bottom of the table. In the new row, click the arrow shown 
in the Activity column and then click the desired PM activity. 

In the PM trigger column, click the arrow and then click the entry in the drop-down list 
for when the PM activity will be performed (after a certain amount of days, after a certain 
amount of miles, or after either days or miles, whichever comes first). 
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After selecting the PM trigger, the system will display a dialog box so you may enter the 
value for the number of days and/or miles. When you close the dialog box by clicking 
OK, these values will be shown in the PM Parameters column. 

 

• To modify an existing row, simply select new values for the Activity and/or PM Trigger 
columns from the drop-down lists. 

• To change when an activity will be performed without changing the PM trigger, point to 
the row, right-click, and then click Define Argument(s). The system will then display a 
dialog box so you may enter new values for the number of days and/or miles. 

 

5. When the PM schedule is correct, click Save.  

7.2  How to Create PM for a Particular Vehicle 

As explained in the introduction to this section, a PM may be created for a class of equipment — and for 
all subclasses and types of equipment that fall within this class. However, in some cases, a PM schedule 
for even a particular type of equipment (the lowest level in the hierarchy) is inadequate. For these cases, 
FMS provides the means to define a PM schedule for a particular piece of equipment or vehicle. 
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To create a PM schedule for a particular piece of equipment: 
 

1. Display the PM by Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > PM by Inventory). An example of this window is shown below. 

 

2. In the Inventory pane, locate the particular vehicle or piece of equipment for which you will 
create a PM schedule. (Tip: use the right-click Find function to quickly get to the vehicle.) 

3. Once the desired piece of equipment or vehicle is found, point to it, right-click, and then click 
Define Its Own PM Setup.  

  

The system places a green square in the Its Own PM column to show that it now has its own PM 
schedule (you may need to scroll to the right to view this column). Note that the existing PM 
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schedule shown in the bottom pane does not change. 

 

4. In the bottom pane, the table shows the PM schedule for the vehicle or piece of equipment 
selected in the Inventory pane. Each row of the table is for a different PM activity. The PM Trigger 
and PM Parameters columns indicate when the activity is to be performed. When both time and 
mileage is indicated as the "PM trigger," the first number in the PM Parameters column indicates 
days and the second number indicates miles. In the following example, the PM Service A activity 
is performed every 180 days or 10,000 miles: 

 

Modify the shown PM schedule to create the PM schedule for the desired class of equipment: 

• To remove a row from the table, point to the row, right-click, and then click Delete. 
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• To insert a row into the table, point to the table, right-click, and then click Insert. The 
system adds a new row at the bottom of the table. In the new row, click the arrow shown 
in the Activity column and then click the desired PM activity. 

In the PM trigger column, click the arrow and then click the entry in the drop-down list 
for when the PM activity will be performed (after a certain amount of days, after a certain 
amount of miles, or after either days or miles, whichever comes first). 

 
After selecting the PM trigger, the system will display a dialog box so you may enter the 
value for the number of days and/or miles. When you close the dialog box by clicking 
OK, these values will be shown in the PM Parameters column. 

 

• To modify an existing row, simply select new values for the Activity and/or PM Trigger 
columns from the drop-down lists. 
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• To change when an activity will be performed without changing the PM trigger, point to 
the row, right-click, and then click Define Argument(s). The system will then display a 
dialog box so you may enter new values for the number of days and/or miles. 

 

5. When the PM schedule is correct, click Save.  

Note:  Once a piece of equipment or a vehicle has its own PM schedule, you may restore it to having the 
same PM schedule as other members of its class or subclass by pointing to the row showing the piece of 
equipment, right-clicking, and then clicking Inherit Parent PM Setup. 
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8 CREATION OF WORK ORDERS 

As described in previous sections, PM schedules contain a "trigger" for when a PM activity is to be 
performed. When the number of days and/or miles elapses, the system generates a PM request. You may 
then use this PM request to create a work order to perform the PM activity. 

Work orders may also be created directly for work performed by a commercial (non-agency) garage. 

This section describes how to create these types of work orders. 

8.1  How to Create a Work Order from a PM Request 
To create a work order from a PM request: 
 

1. Display the PM Work Order window (Fleet Management > Work Orders > Internal Work Orders 
> Create Work Orders). An example of this window is shown below. 

 

2. In the upper left pane, locate the PM request for which a work order will be created. 
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3. Point to the row showing the PM request, right-click, and then click Issue Work. The system 
displays a new work order in the Repair Orders pane.  It will also insert due PM services in the 
bottom pane.  

 

4. In the middle pane, if desired, assign a mechanic to the new work order by clicking the arrow in 
the Mechanic column and then clicking the appropriate mechanic.  

 

5. In the bottom pane, point to the pane, right-click, and then click Insert. The system adds a new 
row to the table.  

 

6. In the new row, click the down arrow in the Activity column and then click the activity that will 
be performed for the work order highlighted in the middle pane. 

7. Repeat steps 5 and 6 for any additional activities that will be performed for this work order. 

8. When all activities are added to the bottom pane, click Save.  

8.2  How to Create a Work Order Directly 
To create a work order without referencing a PM request: 
 

1. Display the PM Work Order window (Fleet Management > Work Orders > Internal Work Orders 
> Create Work Orders).  
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2. In the middle pane, right-click and then click Insert. The system displays a dialog box similar to 
that shown below so you may identify the vehicle or piece of equipment. 

 
3. Enter the identification number of the vehicle or equipment and then click OK. The system adds a 

new row to the table in the middle pane. If the equipment is under warranty, the system displays 
message as shown below.  

                                              

 

4. In the middle pane, if desired, assign a mechanic to the new work order by clicking the arrow in 
the Mechanic column and then clicking the appropriate mechanic. 

5. In the bottom pane, point to the pane, right-click, and then click Insert. The system adds a new 
row to the table. 

6. In the new row, click the down arrow in the Activity column and then click the activity that will 
be performed for the work order highlighted in the middle pane. 

7. Repeat steps 5 and 6 for any additional activities that will be performed in this repair order. 
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8. When all activities are added to the bottom pane, click Save.  

8.3  How to Create a Commercial Work Order 
Occasionally, a repair cannot be performed within your agency. Instead, the repair is performed by an 
outside organization, which is termed a "commercial garage." To create a work order for a commercial 
garage: 
 

1. Display the Commercial Garage Work Order window (Fleet Management > Work Orders > 
Commercial/Inter-Agency Work Orders > Create Work Orders).  

 

2. In the Equipment Name field, type the exact identification number of the piece of equipment or 
vehicle and then click Retrieve. The system checks whether the piece of equipment or vehicle 
exists. If the vehicle has a VIN number on file, it is displayed. If the equipment is under warranty, 
the system displays message as shown below.  
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3. The system displays the information about the vehicle. An example of the window at this point is 
shown below. 

 

4. In the Repair Vendor field of the upper pane, select the type of vendor (Commercial or Inter-
Agency) and in the Vendor Name field, enter the name of the contractor who will perform the 
repair if desired. 

5. Optionally, add any additional or helpful information in the Comments field. 

6. In the lower pane, right-click, and then click Insert. The system displays a new row in the lower 
pane. 

7. In the Activity column, click the arrow and then click the activity that will be performed. 

8. Check what is displayed in the Work Action Code column of the new row. If necessary, change it 
by clicking the arrow and then clicking the work action code for what the Repair vendor did. 

9. Enter the data for Labor Costs and Material Unit Cost and Quantity (of material) in the respective 
columns. Also you can capture Miscellaneous costs, costs other than Labor Cost and Material 
Cost, in the Misc. Costs ($) column. 

10. If the date displayed in the Work Date column is incorrect, tab to this column and type the correct 
date when the repair will be performed. 

11. In the upper pane, set the Status to Active to indicate the work order is now active. 

12. Click Save.  The work order is now defined. 



 AgileAssets Fleet Management System 
 Tutorial 

Proprietary and Confidential © 2008 AgileAssets, Inc. Page 31 

9 WORK ORDER PROGRESS 

Once work on a work order commences, you may create day cards in the Progress window to plan for or 
record the amount of time an employee spends on a repair: 
 

1. Display the Progress window (Fleet Management > Work Orders > Internal Work Orders > Work 
Order Progress). An example of this window is shown below. 

 

This window shows all open work orders other than those assigned to a commercial garage. The 
upper left pane (A) shows the work orders. The upper right pane (B) shows the work activities 
created for the work order selected in the upper left pane. 

The lower part of the window (C) shows the day cards created for the selected work order. These 
day cards show the employee(s) who worked on the work order, and how much time was spent. 

2. In the upper left pane, locate the work order for which day cards will be created and then click 
the row showing this work order to select it. 
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3. In the left pane of the Labor tab, locate the employee who worked (or will work) on the work 
order and then click the check box located beside his or her name.  

 

4. In the right pane of the Labor tab, right-click and then click Insert. The system adds a day card to 
the pane. 

 

5. In the Service column of the new row for the day card, click the arrow and then click the activity 
that the employee performed. 

6. Check what is displayed in the Work Action Code column of the new row. If necessary, change it 
by clicking the arrow and then clicking the work action code for what the employee did. 

7. Check the date shown in the Work Date column. If necessary, change it by highlighting the 
existing date and then typing a new date. 

8. Check what is displayed in the TRC column. If necessary, change it by clicking the arrow and 
then clicking the code for the type of hours (base, vacation, sick, etc.). 

Note that if an employee requires multiple TRC codes (for example, say George Smith worked in 
the morning and took the afternoon off for a medical appointment), you will need to create 
duplicate records for each additional TRC code. This is accomplished by pointing to the row 
showing the employee, right-clicking, and then clicking Insert Like. The system then creates a 
duplicate record, and you may change the TRC code to the appropriate value. 

9. In the Total Hrs column, enter the number of hours the employee spent on this activity.  

10. Repeat steps 3 through 9 for any additional employees. 
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11. Once all day cards are created, point to any row, right-click, and then click Approve All. The 
system then approves all day cards and places a checkmark in the Approved column. 

 

12. If the repair incurred any direct costs (for example, purchase of a part on the way to the job 
site), click the Direct Costs tab. An example of this tab is shown below. 

 

13. Point to the tab, right-click, and click Insert. The system adds a new row to the tab. 

14. In the Repair Vendor column, click the arrow to display a drop-down list of Vendors from which 
purchases may be made and then click the Vendor to select it. 

15. In the Activity column, click the arrow and then click the activity for which the part is purchased. 

16. Check what is displayed in the Work Action Code column of the new row. If necessary, change it 
by clicking the arrow and then clicking the work action code for what the repair vendor did. 

17. Check the date in the Work Date column. If necessary, highlight the date and change it to the date 
that the purchase was made. 

18. Miscellaneous costs, costs other than Labor Cost and Material Cost, can be entered in the Misc. 
Costs ($) column. 

19. If you would like to include any additional information, tab to the Comments column and enter 
the information. 
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20. If you would like to attach any files to support the expenditure (such as an expense report or a 
scan of a purchase receipt), point to the row, right-click, and click Work with Attachments. The 
system then displays the following dialog box so you may select the file to attach to the record. 

 

21. In the dialog box, click Add. The system displays a dialog box for you to select the file. 

22. In the Select File dialog box, click Browse. The system displays the hierarchy of drives, folders, 
and files on your computer and network. 

23. Locate the desired file and double-click on the file name. The system closes the hierarchy dialog 
box and displays the file name in the Select File dialog box. 

 

24. Click Upload. The system attaches the selected file to the record. The Work with Attachments 
window remains open so you may select additional files for attachment. 

25. Repeat steps 19 through 22 for any additional files. 

26. Click the close button in the upper right corner of the Work with Attachments dialog box. 

The system closes the dialog box and a red square appears in the Att. column of the 
Direct Cost record to denote that attachments are associated with this record. 

27. In the Approved column, click the check box. 
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28. Repeat steps 12 through 27 for any additional "direct cost" expenditures. 

29. If the parts used in the repair are covered by a warranty, click the Warranties tab. An example of 
this tab is shown below. 

 

30. Point to the tab, right-click, and then click Insert. The system adds a row to the table. 

31. In the Warranty column, type a description of the part covered by a warranty. 

32. Tab to the Date column and type the date that the warranty begins. 

33. If the part was installed in a vehicle, tab to the Initial Odometer column and enter the odometer 
reading of the vehicle. 

34. In the Warranty Rule column, click the arrow to display the drop-down list of warranty rules and 
then click the appropriate entry for the warranty. After selecting the warranty rule, the system 
displays a dialog box so you may enter the value(s) for the warranty rule. 

 

35. Enter the values for the warranty rule in the appropriate column(s). 

36. Click OK. The system closes the dialog box and shows the entered values in the Warranty Trigger 
Arg column. 

37. If you would like to include any additional information, tab to the Comments column and enter 
the information. 

38. If you would like to attach any files to support the warranty (such as a scan of the purchase 
receipt), repeat steps 19 through 26 to associate an attachment with the record. 
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39. Repeat steps 30 through 38 for any other parts used in this repair that are covered by warranties. 

40. Once all information for the work order has been entered, click the checkbox in the Ready for 
Completion column so that the work order can be closed. 

41. Click Save.  
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10 WORK ORDER COMPLETION 

10.1  How to Close a Work Order 
When all time and costs have been recorded for a work order and no more work is to be charged to that 
work order, you should close the work order as described in the following steps: 
 

1. Display the Completion window (Fleet Management > Work Orders > Internal Work Orders > 
Complete Work Orders). This window list internal work orders that have been marked Ready for 
Completion. An example of this window is shown below. 

 

2. In the lower pane, verify the Not Approved column. To close a work order, all day cards for the 
work order must be approved. This column indicates how many day cards are not approved. If 
this column shows all zeros, go to the next step. 

For any type of day card that has unapproved day cards, you have two choices:  you may 
approve the day cards or delete them. To approve all unapproved day cards, point to the selected 
work order in the upper pane, right-click, and then click Approve All. To delete unapproved day 
cards, point to the selected work order, right-click, and then click Delete Unapproved. 
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3. In the upper pane, select the check box in the Completed column for the selected work order. 
Verify the completion date. This is very important since the system date is used as the default 
completion date. 

4. Click Save.  The work order is now closed.  

10.2  How to View a Closed Work Order 
Once a work order is closed, it will not be displayed in any window of the system other than the 
Completion window provided the date the top of the window is the date that the work order was closed 
or earlier. To display a closed work order: 
 

1. Display the Completion window (Fleet Management > Work Orders > Internal Work Orders > 
Complete Work Orders).  
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2. In the Show Completed From field at the top of the window, enter a date that is before the date 
that the work order was closed. 

 

3. Click Retrieve. The system displays all work orders that were closed on or before the date you 
entered at the top of the window. 

4. In the Repair Orders pane, locate the work order and click the row showing this work order to 
view the details about the work in the other panes. 

10.3  How to Open a Closed Work Order 
To open a closed work order: 
 

1. Display the Completion window (Fleet Management > Work Orders > Internal Work Orders > 
Complete Work Orders).  
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2. In the Show Completed From field at the top of the window, enter a date that is before the date 
that the work order was closed. 

 

3. Click Retrieve. The system displays all work orders that were closed on or before the date you 
entered at the top of the window. 

4. In the Repair Orders pane, locate the work order and click the row showing this work order. 

5. Click the check box in the Completed column to remove the checkmark. 

 

6. Click Save.  

The work order is now open, and may be viewed in other windows of the system. 

10.4  How to Close a Commercial Work Order 
To close a commercial work order: 

1. Display the Completion window (Fleet Management > Work Orders > Commercial / Inter-
Agency Work Orders > Complete Work Orders). This window will list all the active commercial 
work orders. An example of this window is shown below. 
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2. Locate the work order you would like to close in the top pane. Change the status to Completed. 

3. Before closing the Work Order, the Miscellaneous Costs can be modified in the Misc. Cost ($) 
column at the bottom pane. 

 
4. Verify the completion date and change it if necessary. 

5. Click Save.  

10.5  How to View a Closed Commercial Work 

Order 

Once a work order is closed, it will not be displayed in any window of the system other than the 
Completion window provided the date the top of the window is the date that the work order was closed 
or earlier. To display a closed work order: 
 

1. Display the Commercial Work Orders Completion window (Fleet Management > Work Orders > 
Commercial / Inter-Agency Work Orders > Complete Work Orders).  
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2. Check the box at the top and in the Show Closed From field at the top of the window, enter a date 
that is before the date that the work order was closed and in the to field enter a date that is after 
the date the work order was closed. 

 

3. Click Retrieve. The system displays all commercial work orders that were closed on or before 
the date you entered at the top of the window. 

4. In the Repair Orders pane, locate the work order and click the row showing this work order to 
view the details about the work in the other panes. 

10.6  How to Open a Closed Commercial Work 

Order 
To open a closed work order: 
 

1. Display the Completion window (Fleet Management > Work Orders > Commercial / Inter-
Agency Work Orders > Complete Work Orders).  
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1. Check the box at the top and in the Show Closed From field at the top of the window, enter a date 
that is before the date that the work order was closed and in the to field enter a date that is after 
the date the work order was closed. 

 

2. Click Retrieve. The system displays all commercial work orders that were closed on or before 
the date you entered at the top of the window. 

3. In the Repair Orders pane, locate the work order and use the dropdown in the status column to 
change the status to Active. Clear the Completion Date if necessary. 

 

4. Click Save.  

The work order is now open, and may be viewed in other windows of the system. 
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11 WORK ORDERS AND ACCIDENTS 

In any work order window where a table of work orders is displayed, right-clicking a work order will 
display menu items to Assign to accident and Unassign accident. This tutorial will explain how to 
use these items. 

11.1  Assign Work Order to Accident 
To assign a Work Order to an Accident: 

1. In any Work Order window that is displaying a table of work orders, locate the work order you 
wish to assign to an accident and right-click on the row and click Assign to accident. An 
example of this window is shown below. 

 

2. Select the appropriate accident by clicking the row and then clicking the OK button. The 
accident_id column on the work order is now populated. 

3. Click Save.  The work order is now assigned to the accident. 

11.2  Unassign Work Order from Accident 

To unassign a work order from an accident: 

1. In any Work Order window that is displaying a table of work orders, locate the work order 
which is assigned to an accident you want to unassign. Right-click on the row and click 
Unassign accident. The accident_id column is cleared. 
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2. Click Save.  The work order is now unassigned from the accident. 
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12  INVENTORY INFORMATION 

A large quantity of information is available for the equipment and vehicles that are assigned to your 
agency. This information is collected in one window to facilitate data capture and maintenance. This 
window is the Equipment Inventory window. This section discusses this window and the information 
contained in it. 

12.1  How to Display Inventory Information 
To display inventory information:  
  

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. The system displays the equipment that is assigned to your management unit. An example of the 
Equipment Inventory window is shown below. 

 

Note: Since many columns are provided for each equipment, you may find it easier to point to a 
row, and then double click  on the icon Show as a Free Form  (top left corner of the pane)  
instead of scrolling to view the columns outside the pane. When you use this command, the 
window display switches from grid view to form view and displays all columns as fields. This 
window displays more information at one time, and many find it to be quicker and easier to read. 
You can double click again on the same icon Show as a grid  (top left corner of the pane) to 
return to the grid view. 
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12.2  Maintaining Information for Inventory Items 
You can add, modify or delete equipment from the Equipment Inventory window by using the right click 
menu options and editing the existing data directly. The following sections show you how to add certain 
types of information for a piece of equipment. 

12.2.1 How to Add Warranty Information 
To add warranty information for a piece of equipment or vehicle:  
 

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. In the Inventory pane, locate the equipment for which warranty information will be added. 

3. Click the row showing the desired equipment. The system highlights the row. 

4. Click the Warranties tab. An example of this tab is shown below. 

 

5. Point to the Warranties tab, right-click, and then click Insert. The system adds a new row to the 
table. 

 

6. In the new row, click in the Warranty column and enter a name or an ID number for the warranty. 

7. Tab to the Date column and enter the date that the warranty started. 

8. For vehicles with an odometer, tab to the Initial Meter column and enter the odometer reading 
when the warranty began. 

9. Click the arrow shown in the Warranty Rule column and then click the "unit" for the warranty 
(after a certain amount of days, after a certain amount of miles, or after either days or miles, 
whichever comes first) in the drop-down list. After selecting the warranty unit, the system will 
display a dialog box so you may enter the value(s) for the selected unit. 
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10. In the dialog box, enter the number of miles, or days, or both, that is covered by the warranty. 

11. Click OK to close the dialog box. 

12. Optionally, add any additional or helpful information in the Comments column. 

13. Click Save.  The warranty is now associated with the equipment. 

You may enter as many warranties as needed. 

12.2.2 How to Add Fueling and Fluids Log Data 
The Equipment Inventory window contains a tab that documents all fueling or fluids transactions made 
for the equipment selected in the Inventory tab. To add data: 

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. In the Inventory pane, locate the equipment for which fueling/fluids data will be added. 

3. Click the row showing the desired equipment. The system highlights the row. 

4. Click the Fueling and Fluids tab.   

5. This pane will display all Fueling and Fluids transactions for the selected equipment. An example 
of this tab is shown below.  
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6. Right click in the Fueling and Fluids pane and click Insert. The system adds a new row. 

 

7. Enter Fuel Type/Incidentals, Date, Amount, Costs , Source, and Method of Payment as required. 

8. If you are drawing the fuel from an internal tank, select an internal tank in the Internal Tank 
column (Internal must be selected as source). 

9. Click Save  to save the new record. 

 

Note: If you are selecting a Fuel Type not supported by the vehicle, the system will prompt you. If this 
vehicle should support this type of fuel, you should add it in the Number of Fuel Type pop-up window 
in the Inventory tab for the selected vehicle as shown below. 

 

 

12.2.3 How to View Repair History Logs 
The Equipment Inventory window contains a Repair History tab that documents all work order 
summaries made on the piece of equipment. This information is taken from other windows in the system, 
and as such is shown here for your information. You cannot modify information shown in these tabs. An 
example of the Repair History tab is shown below. 
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12.2.4 How to Add Accident Information 
Accidents Tab documents all accidents for the equipment.  

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. In the Inventory pane, locate the equipment for which you want to view, add, or edit accident 
information. 

3. Click the row showing the desired equipment. The system highlights the row. 

4. Click the Accidents tab.  This pane will display all accident information for the selected 
equipment unit. An example is shown below. 

 

5. Right-click in the Accidents pane and click Insert. The system adds a new row. 

6. Enter accident information as required. 

7. Click Save  to save the new record.  

12.3  Equipment Inquiry 
The Equipment Inquiry window allows you to locate and display information about any piece of 
equipment in inventory. To retrieve information about a piece of equipment: 

1. Display the Equipment Inquiry window (Fleet Management > Setup/Inventory > Equipment 
Inquiry). 

2. In the dropdown box in the top left of the window, select your search criteria (for example VIN or 
Plate). 

3. Enter your search parameter in the second box in the top of the window (for example 12345). You 
can use wildcards in the search parameter such as % or *. 

4. Click on the Show Inventory button to display the information for the desired piece of 
equipment. If your search returns more than one result, the system will display each result on a 
separate page (look at the number of pages on the navigation toolbar at the top of the window 
pane). 
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12.4  Equipment Acquisition 

The Equipment Acquisition window is used to record new equipment acquisitions. In an acquisition 
transaction, you may buy a single piece of equipment or multiple pieces of the same type of equipment. 
Recording acquisitions is a two-step process. First, you determine what and how much was purchased to 
create an acquisition transaction. Then, when the acquisition is approved, you check the box in the 
Accepted column which adds the equipment to your administrative unit’s inventory. To acquire 
equipment(s): 

1. Display the Equipment Acquisition window (Fleet Management > Setup/Inventory > Equipment 
Acquisition). 

 
2. In the Class Code pane, right-click on the Equipment Class Code you want to purchase and select 

Acquire this Equipment. A new row is added in the bottom pane of the Acquisition tab. 
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3. In the bottom pane, enter the number of vehicles of this type that you are purchasing in the 
Acquisition tab. 

 

4. Click on the Names tab and enter the names of the Equipment you are purchasing. 

5. Click on the Common Data tab and enter all the common information to the purchased vehicle(s). 
When you acquire some equipments, the ownership fields are prefilled to your unit. 

6. Once satisfied, click the Save button.  

7. Click on the Acquisition tab, and check the Accepted box. 

8. Click on Save.   

The new equipment is added to the Equipment Inventory with a status of “I - Inactive”. 

 

Note: It is necessary to complete all the steps mentioned above before you start a new acquisition. 
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13 HOW TO MAKE A VEHICLE READY FOR 

DISPOSAL 

At the end of service life, or on certain events (like transfers), it is necessary to change the status of a 
specific vehicle from the active inventory. The logical progression is to go from an active status to a 
pending sale status. To dispose off of an equipment, follow these steps:  
  

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. In the Inventory pane, locate the equipment for which you want to view, add, or edit accident 
information. 

3. Click the row showing the desired equipment. The system highlights the row. 

4. Enter the correct date in the Out-of-Service Date column. 

5. Change the Equipment Life Status to P – Pending Sale or Disposal. 

 

6. Click on Save.   

 

Note: If you have open repair order on the equipment you are disposing off, the system will notify you 
when to change the status of the vehicle. 
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14 HOW TO DISPOSE OFF A VEHICLE 

At the end of service life, or on certain events (like transfers), it is necessary to change the status of a 
specific vehicle from the P - Pending Sale or Disposal inventory. The logical progression is to go from an 
pending status to a retired status. To dispose of an equipment, follow these steps:  
  

1. Display the Equipment Inventory window (Fleet Management > Setup/Inventory > Equipment 
Inventory > Equipment Inventory). 

2. In the Inventory pane, locate the equipment for which you want to view, add, or edit accident 
information. 

3. Click the row showing the desired equipment. The system highlights the row. 

4. Enter the Disposal Method, Disposal date and the Net Disposal Proceeds as required, you can 
also capture Disposal Comments and Disposal Cost (agency cost) if you desire. 

5. Change the Equipment Life Status to P – Pending Sale or Disposal. 

 

6. Click on Save.   

 

Note: If you have open repair order on the equipment you are disposing off, the system will notify you 
when to change the status of the vehicle. 
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15  HOW TO UPDATE ODOMETER READINGS 

An important piece of information for vehicles is the odometer reading. This reading is vital in 
determining usage and when periodic maintenance may be required. FMS provides a window for 
capturing all odometer readings once a month. To enter an odometer reading:  
  

1. Display the Odometer Entry window (Fleet Management > Setup/Inventory > End of Month 
Odometer). 

2. In the Class Codes pane, select the equipment class code corresponding to the equipment you 
wish to display by pointing to the desired type, right-clicking, and then clicking the appropriate 
selection commands. Repeat this procedure for any additional types you wish to select. (You may 
also use the displayed shortcut menu to de-select equipment classes.) 

3. In the Status pane, click the status corresponding to the equipment you wish to display. You 
select multiple, adjacent statuses by clicking the first status, holding down SHIFT, and then 
clicking the last status in the group. You select multiple, non-adjacent statuses by clicking the first 
status, holding down CTRL, and then clicking each additional status. 

4. Click Retrieve. The system displays the equipment that meets the specified criteria in the pane. 
An example of this window is shown below. 

 

5. Check the month and year shown at the top of the pane on the right side. If necessary, select a 
new date by clicking the arrow shown in the field and then clicking the appropriate month and 
year from the drop-down list. 

6. Locate the vehicle and enter its odometer reading in the End Month Odometer column. 
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7. Click the Approve check box. 

 
8. Repeat steps 6 and 7 for all vehicles. 

9. Click Save.  

After the odometer readings have been reviewed and approved, the system administrator runs a system 
job that associates the approved odometer readings with the vehicle. This allows the odometer readings 
found in the Equipment Inventory window to be updated with the ones entered in the End of Month 
Odometer window. 
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16  RESOURCES – LABOR INVENTORY 

The Labor Inventory or Employees window lists all the labor resources assigned to the Management Unit 
the user is currently signed in to.  

16.1  How to Add Employees 

1. Display the Labor Inventory window (Resources> Labor > Inventory > Labor Inventory). 

 

2. Right click and Insert a new record. 

3. Edit/enter column information as needed. 

4. Click Save   to save the record. 

 

16.2  How to Add Licenses 
1. For the employee selected in the inventory tab you can enter the licenses acquired by that 

employee. 
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2. Right Click and Insert a new record. 

 

3. From the License dropdown choose the required license. 

4. You can insert multiple licenses for one employee. 

5. Click Save   to save the record. 
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17 RESOURCES – MATERIAL INVENTORY 

The Material Inventory window allows you to view the available quantities of all inventory items relative 
to the "full" stockpile amount as well as track the inflow and outflow of material over time. Additionally, 
you may edit certain information to keep inventory data up-to-date and check on materials that have 
been planned for or assigned in advance to ensure you have sufficient quantities available. 

17.1  How to View Transaction Details 
To view the transaction details for the inflow and outflow of a stock item: 

1. Display the Material Inventory window (Resources > Materials > Inventory > Material 
Inventory). 

 
2. If necessary, in the Material Class Codes pane, select the material classification code for the stock 

item and then click Retrieve . The Material List in the Inventory tab displays the stock items 
that match the selected classification codes. 

3. In the Material List pane of the Inventory tab, click the row showing the stock item for which you 
wish to see inflow and outflow transaction details. 
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4. Click the Transaction History tab. The transaction details for the stock item are shown. 

 

17.2  How to Set the Reorder Point 
To set the full amount of a stock item and item reorder point: 

1. Display the Material Inventory window (Resources > Materials > Inventory > Material 
Inventory). 

2. If necessary, in the Material Class Codes pane, select the material classification code for the stock 

item and then click  (Retrieve Data icon) The Material List pane in the Inventory tab displays 
the stock items that match the selected classification codes. 

3. In the Material List pane of the Inventory tab, locate the stock item. 

4. In the row showing the desired stock item, click in the Threshold to Purchase column and enter 
the percentage of the full amount at which re-ordering should occur (You may need to scroll to 
the right to see this column). Note that the percentage is typed as a decimal value (for example, 
15% is typed as 0.15). 

 
5. Tab to the Full Capacity column and enter the value for what constitutes a "full" quantity of this 

stock item for the given inventory bin. 
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6. Click Save . 

 

 

17.3  How to Create a New Stock Item (Fuel Tank) 
Creating new fuel tanks involve a three steps process: 
 

- First, receive a new material in the Material Management Window 
- Second, create a new fuel tank name 
- Third, assign the tank name to the new material created in the first step. 

 
To create a new Fuel Tank, follow these steps: 
 

1. Open the Material Management window (Resources > Materials > Inventory > Material 
Management). 

2. In the Class Code pane (bottom left), right click on the TxCPA Fuel Storage Tanks classifincation 
code and then select Receive this material. 
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3. A pop-up window opens. In this window, select the type of Fuel Storage Tank you want to create 
(for example Bio-Diesel Storage Tank). Click on OK. The pop-up window closes 

 

4. A new transactions appears in the Transactions pane. Precise the Quantity Received and the Unit 
Costs if necessary. 

 

5. Click the Accepted checkbox (Fulfilled is checked automatically) and then click on icon Save 

. 

6. Open the List of Fuel Storage Tanks window (Resources > Setup > List of Fuel Storage Tanks) 

7. Right-click Insert. The system adds a new row (corresponding to a new tank name). 

 

8. On the new record, define the Tank Name and verify that the Parent Agency is appropriate (per-
filled to your agency). 

9. Click Save . 

10. Open the Material Inventory window (Resources > Material > Inventory > Material Inventory) 
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11. In the Material Inventory pane (left pane), locate the new material inventory without a name 
(column Tank Name is empty) and select the Tank Name created in Step 8. 

 

12. If necessary, adjust the Full Capacity and Threshold to Purchase values for this new material 
stock.  

13. Click Save . 
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18 RESOURCES – MATERIAL MANAGEMENT 

In the Material Management window the user can initiate and process transactions on material resources, 
such as bulk fuel. Materials can be transferred between administrative units in the same agency (that is, 
between units that use this system). In contrast, purchasing and selling are between an administrative 
unit and an outside vendor (that is, between a user of this system and an outside entity that does not). 

18.1  Color Coding for the Stock List Window 
In the Material Management window, the system indicates the level status for each stock item in an 
inventory. The following color coding is used in the Stock List pane: 
 

 No color — The current amount of stock on hand is above the threshold to purchase, but less 
than the full amount. 

 Yellow — The amount of stock on hand is close to the threshold to purchase.  
 Orange — The amount of stock on hand is equal to or below the threshold to purchase. 
 Red — The amount of stock on hand is zero. 
 Green — The amount of stock on hand is greater than the full amount. 

 Blue — The value for the Full Amount or Threshold to Purchase column is zero. 

18.2  Transferring Materials 
The transfer of material between administrative units is initiated from the destination unit by creating a 
transfer-in transaction: 

14. Display the list of materials for the administrative unit from which the material is to be requested 
(the "source unit") and locate the stock item that will be requested (Resources > Materials > 
Inventory > Material Management). 

15. Point to the desired material, right-click, and then click Ask For Transfer From This Stock. A 
new record is added to the Transactions pane. 
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16. In the new row in the Transactions pane, click in the Quantity Received column and enter the 
amount requested. 

17. Repeat steps 2 through 3 for any additional materials to be requested. 

18. When all transfer-in transaction records are created, click Save . 

19. Click Retrieve to refresh the window. The source unit must now do its part to fulfill the 
transaction. 

20. The next time that the source unit opens the Resources module, they will receive a message that 
materials are requested from them by the destination unit. The source unit then completes the 
request as follows: 

 
21. Navigate to the Materials Management window and display the list of materials. 

22. If you wish to transfer the requested stock item, select the check box in the Fulfilled column for 
the request. 
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23. Repeat step 3 for all requests. When all requests are fulfilled, click Save . 

24. Click Retrieve . Note that in the Material List pane the current amount value does not change 
even though the request is fulfilled. This is because the requester has not yet accepted the transfer 
of materials. This will be accomplished in the following steps. 

25. The next time the requesting unit opens the Resources module, they will receive a message that 
their request for material was fulfilled. The requesting unit then completes the transfer as follows: 

 
26. Navigate to the Materials Management window and display the list of materials. 

27. In the row showing the requested materials in the Transactions pane, select the check box in the 
Accepted column. 

 

28. Repeat step 2 for all requests. When all requests are accepted, click Save . 
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29. Click Retrieve . Note that in the Material List pane the current amount value for both the 
requesting unit and source unit are updated. 

Note: The records in the Transactions pane will remain as an historical record of transfers. 

18.3  Receiving Materials 
1. Display the list of materials for the target administrative unit and locate the stock item that will 

be purchased (Resources > Materials > Inventory > Material Management). 

1. In the Material List pane, locate the stock item to be purchased. Point to this stock item, right-
click to display the shortcut menu, and then click Receive Into This Stock. A purchase 
transaction is created in the Transaction pane. 

 

2. In the new record in the Transactions pane, click in the Quantity Received column and enter the 
amount to be purchased. 

 

3. If necessary, tab to the Measurement Unit column, click on the arrow, and then click on the 
desired unit. Note that the system automatically converts between units. 

4. Click Save . The transaction is now pending, and will be completed when the stock item 
arrives. 

5. Note that the current amount value for the stock item does not change. 
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6. When the stock item arrives, locate the purchase transaction for the stock item. 

7. In the Accepted column, select the check box. 

 

8. Click Save . The purchase transaction is now complete. 

9. Click Retrieve . 

18.4  Making Corrections 

To make corrections to the amount of a material and its unit cost: 
1. Display the Material Management window (Resources > Materials > Inventory > Material 

Management). 

2. In the Material List pane, locate the stock item to be corrected. Point to this stock item, right-click 
to display the shortcut menu, and then click Make Correction. This creates a correction record in 
the Transactions pane. 

 

3. In the new record, click in the Quantity Received column and enter the actual amount that is 
currently in that stock bin. (If the full amount is correct, but the unit cost is wrong, do not make 
any changes to this column.) 

4. Click in the Unit Cost column and enter the actual unit cost for this material. (If the unit cost is 
correct, but the full amount is wrong, do not make any changes to this column.) 

5. Select the check box in the Accepted column. 
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6. Click Save . The correction transaction is now complete. 

7. Click Retrieve. The system updates the display of the current amount and the unit cost values in 
the Material List window for the stock item. 
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19 RESOURCES - MATERIAL 

RECONCILIATION 

The Material Reconciliation window is used to make stock reconciliations for a warehouse, with locking 
and unlocking (or "freezing" and "unfreezing") of material transaction approvals for that part of the 
warehouse being reconciled during the course of the reconciliation process. 

19.1  New Reconciliations 

To initiate a new reconciliation:  
1. Open the Material Reconciliation window (Resources > Materials > Inventory > Material 

Reconciliation). 

2. Right click and Insert a new record to initiate a new reconciliation. 

3. In the dialog box, select the Master Codes you want to reconcile. Once satisfy, click on OK. 
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4. Right-click on Freeze Reconciliation. 

 

5. Click on the second tab “Count”. 

6. In the “Count” tab, you can see all the material inventories you agency owns. You can make 
count correction and unit cost correction by entering the correct values in the Current Amount 
Reconciliation and in the Unit Cost Reconciliation columns. 

 

7. Click on Save . 
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8. Go back to the Freezing tab. If satisfied, right-click on the reconciliation row and select Complete 
Reconciliation. 
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20 MOTOR POOL RESERVATIONS 

The Motorpool User Reservations window provides fields to record information about the type of vehicle 
to be rented and who will be renting the vehicle. Only pending reservations (that is, reservations to which 
a vehicle has not yet been assigned) are shown in this window. 

When you right-click, a shortcut menu is displayed. This menu provides the common commands along 
with the following special commands:  

• Make New Reservation -- This command inserts a new record in the window. 
• Assign Vehicle -- This command uses the entered equipment class code to locate an available 

vehicle of the type and then assign this vehicle to the reservation. Once assigned, the ID number 
of the vehicle is shown in the Equipment field. 

• Submit Reservation -- This command causes your request (or modified request) to be sent to the 
motor pool group. 

• Update User Info -- This command allows you to modify your user information, including to 
what agency (lease owner) you belong and your e-mail address. When this command is selected, 
a dialog box opens that shows your user-related information. Modify the displayed information 
as needed and then click OK to save the new information. 

20.1  How to Create a Reservation 
To create a reservation for a short-term vehicle rental: 
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1. Display the Motorpool User Reservations window (Fleet Management > Tools > Motorpool User 
Reservations). 
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2. Right-click the pane and then click Make Reservation or click the New Reservation button. A 
new record is added to the pane. An example is shown below. 

 

3. In the Vehicle Class field, click the down arrow and then click the type of vehicle that will be 
rented. 

 
4. Enter the driver's name and destination in the appropriate fields. 

5. Check the dates and times shown in the Start Date, Start Hour, Final Date, and Final Hour 
columns. The beginning date will be today's date, with the starting time being the start of the 
work day. The ending date will also be today's date, but the ending time will be the end of the 
work day. If any of these are incorrect, edit the displayed information as needed. 

6. Complete any remaining fields for which you have information. 

7. Once all information is correct, right-click the pane and then click Submit Reservation or click the 
Submit Reservation button. The reservation is now created, but pending. It will be activated 
when a vehicle is assigned to the reservation by motor pool personnel utilizing the Motorpool 
window. Once activated the reservation will no longer be shown in the Motorpool Reservation 
Request window. 
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20.2  How to Delete a Reservation 
Note:  You can only delete reservations that are pending. 

To delete a reservation, follow these steps: 
1. Display the Motorpool User Reservations window (Fleet Management > Tools > Motorpool User 

Reservations).  

 

2. Locate the reservation you wish to delete. 

3. Right-click the record showing the reservation and then click Delete. The reservation is now 
deleted. 

4. Click Save.  
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21 MOTOR POOL DISPATCH 

FMS provides a feature for employees to make short-term reservations of vehicles that belong to your 
agency. This section describes the steps needed to reserve a vehicle. 

The Motorpool Dispatch window contains the following panes: Accessories, Equipment Class Codes, 
Motorpool, and Reservations. 

The window also contains a field for entering a date that filters the displayed records to just those records 
for finalized reservations (that is, completed reservations where the vehicle was taken out and returned) 
where the end date is on or after the entered date. (You must also select the Show Finalized check box to 
show finalized reservations.) 

The Show Finalized check box also filters the displayed records (complete, active, and pending 
reservations). When selected, it causes all records to be displayed; when it is clear, only records for 
pending or active reservations are displayed. 

21.1  How to Create a Reservation 

To create a reservation for a short-term vehicle rental: 
1. Display the Motorpool Dispatch window (Fleet Management > Tools > Motorpool Dispatch). 

2. In the Reservations pane, point to the pane, right-click, and click Insert. A new record is added 
to the pane. An example of this window is shown below. 
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3. In the Vehicle Class column, click the down arrow and then click the type of vehicle that will be 
rented. (Note that it is not necessary at this point to select the actual vehicle.) 

 

4. In the User column, click the down arrow in this column and then click the name of the person 
who is making the reservation. 

 

5. Check the dates and times shown in the Start Date, Start Hour, Final Date, and Final Hour 
columns. The beginning date will be today's date, with the starting time being the start of the 
work day. The ending date will also be today's date, but the ending time will be the end of the 
work day. If any of these are incorrect, edit the displayed information as needed. 

6. Click Save.  The reservation is now created, but pending. It will be activated 
when a vehicle is assigned to the reservation. Click here for instructions on assigning a vehicle. 

21.2  How to Activate a Reservation 
A pending reservation is activated by assigning a vehicle to the reservation as described below: 
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1. Display the Motorpool Dispatch window (Fleet Management > Tools > Motorpool Dispatch). 

 

2. Type the beginning date of the reservation in the field at the top of the window. (Double-clicking 
a date field will display a calendar to assist you in selecting dates.) 

3. If necessary, select the type of vehicle to be rented in the Class Codes pane. (The system will 
remember what you last selected, so you may not need to select a vehicle type.) 

4. Click the Retrieve  icon. The system will display all vehicles that match the selected Class 
Codes in the Motorpool pane. The system will also display existing reservations that fall between 
(and include) the dates set at the top of the window in the Reservations pane. 

5. In the Reservations pane, click the row showing the reservation to be activated. The row is 
highlighted. You may need to double click the form icon to display rows or you can page to the 
correct reservation in the form view. 
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6. In the Motorpool pane, point to the vehicle to be assigned, right-click, and click Assign Vehicle. 
The system will assign the vehicle to the highlighted reservation, with the vehicle name 
appearing in the Equipment column of the Reservations pane. 

 
7. Check the information displayed in the Odometer Out column. If this information is missing or 

incorrect, type the correct information over the old information. 

8. Complete any other columns for which you have information. 

9. Click Save.  The reservation is now active; the short-term rental of the vehicle has 
begun. 

21.3  How to Terminate a Reservation 
When the short-term rental of a vehicle ends, perform these steps to complete the reservation:  

1. Display the Motorpool Dispatch window (Fleet Management > Tools > Motorpool Dispatch). 
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2. Type the beginning date of the reservation in the appropriate fields at the top of the window. 
(Double-clicking a date field will display a calendar to assist you in selecting dates.) 

3. Click Retrieve . The system will display all vehicles assigned to your administrative unit that 
match the selected Class Codes in the Motorpool pane. The system will also display pending and 
active reservations that fall after (and include) the date set at the top of the window in the 
Reservations pane. 

4. In the Reservations pane, locate the reservation for the vehicle being returned. 

5. In the row showing the reservation, type the odometer reading in the Odometer In column . 

 

6. Click Save.  The reservation is now complete, and will not be displayed in the 
Reservations pane unless the Show Finalized check box is selected. 
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22  INDIRECT COST 

This window contains the indirect costs for your agency for each year. To enter your indirect costs: 

1. Display the Indirect Costs window (Fleet Management > Tools > Indirect Costs (per 
agency/year)). 

 

2. Right-click and then select Insert. A new record is added. 

3. The Agency field is prefilled to your agency. 

4. Select a year from the drop-down in the Year column. 

5. Enter the necessary indirect costs for your agency. 

6. The Total Indirect Costs column is recalculated automatically. 

 

7. Click Save.  
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23  INTRODUCTION TO REPORTS 

The FMS database contains a considerable quantity of data – a large portion of which is entered by the 
maintenance personnel as annual plans, service requests, work orders, timesheet data, etc. However, the 
primary reason for entering data is to be able to report it back afterwards in some form or another since 
only then does it really become valuable information. 

23.1  Report Source Data 
Reports are based on what are called “views” (which are created by your System Administrator). These 
views are essentially various ways of organizing and relating the parameters and variables of the 
database system. 

A report may be thought of as an excerpt of a particular view — certain columns of data are extracted 
from the view, sorted or filtered (or otherwise manipulated) as needed, and then formatted into a 
printable document. These kinds of reports may be tabular, customized, or graphic as discussed below. 

The important thing to remember when building reports is that a report should not be 1,000 pages long. If 
you wish to see specific information, you should try to query the database for just this information. If you 
follow the philosophy “I’ll ask for everything and find what I’m looking for once it gets here,” you will 
put a huge strain on the database (and response times will become very slow). 

Homing in on what you really want to see can be done in two ways: either you can summarize your data 
by cutting down on the number of columns or you can set data filters so that you get fewer rows. As 
shown in the diagram below, for large views this may result in a number of different reports with 
different objectives: either high-level summary reports in which the columns are aggregated/restricted or 
filtered detailed reports in which you restrict the rows (for instance to only a specific supervisor in your 
county). 

Summary Report
At High Level

(restricted columns)

Filtered Report
At Low Level

(restricted rows)

= Report

Rows

Co
lu

m
ns

View:
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23.2  Report Types 
The system provides extensive reporting capabilities. At the broadest level, it supports the following 
types of reports: 

 Standard reports – This type of report is selected from the Reports menu item and displays 
data in the same way that it is displayed on the screen, which is similar to a screen report. 

 Jasper reports – This type of report is selected from the Reports menu item and displays data in 
a customized format provided by AgileAssets. 

 Graph reports – This type of report is selected from the Reports menu item and displays data 
in a graphical format. 

In addition, reports are specific to a certain module (Fleet Management, Resources, etc.). In other words, 
Fleet Management has one set of reports — and Resources would have a different set of reports. 

23.3  Report Ownership 
Reports in FMS are “owned” by an administrative unit, and only that unit may view the report. This 
means that a division office may own (and see) one set of reports, while the county maintenance yard 
may own (and see) a different set of reports. This allows each administrative unit to develop a 
customized set of reports. 

If desired, the administrative unit may make a report "public." This means that any administrative unit in 
your organization may view the report. This is also a good way to develop new reports:  use a public 
report that provides information similar to what you want to see, customize it for your purposes, and 
then save it under a new name. 
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24 REPORTING VIEWS AND CONTENT DESCRIPTION 

The Fleet Management System contains the following views that can be used to generate various reports. The description of each view may 
help to make decision about the view that should be used when trying to setup a report. 

No. Module FMS View Name Description 

1 Fleet Management REPORT_AGENCY_CAP 
Report containing the vehicle count per agency and a flag for the agencies exceeding 
the General Purpose Vehicle Limit. – Statewide 

2 Fleet Management REPORT_EQUIPMENT_PM 
Preventive Maintenance Report – Fleet Statewide (for each equipment) – Contains the 
last and the next PM activities for each equipment. 

3 Fleet Management REPORT_EQUIPMENT_REPAIR_HIST Vehicle Repair History (type & date of repair, cost, etc). 

4 Fleet Management REPORT_EQUIP_EXP_UNIV 
Contains summarized data per month for all the costs associated with the vehicle, for 
all the vehicles. 

5 Fleet Management REPORT_EQUIP_FUELING Contains the fuel and incidentals transaction related data. 

6 Fleet Management REPORT_EQUIP_INVENTORY 
Complete vehicle inventory (Contains all the information regarding the vehicle and its 
details & attributes). 

7 Fleet Management REPORT_EQUIP_MIN_USE 
Contains the fiscal-year-to-date data by equipment and month for usage, fuel amount 
and fuel costs, as well as a flag for vehicles violating the minimum use criteria 

8 Fleet Management REPORT_FUEL_TYPE 
Contains all the Fuel Types for each equipment (as defined in the equipment 
inventory) 

9 Fleet Management REPORT_SETUP_PROJECT 
Contains all the repair order information (aggregated by repair order), for all the 
vehicle 

12 Resources REPORT_MATERIAL_INVENTORY 
Contains the material inventory (all the information captured in the resource module 
regarding materials) 

13 Resources RPT_LABOR_LICENSE_EXP 
Contains the list of licenses of the in-house labor resources that have/will expired in 
± 30 days  

15 Resources REPORT_LABOR_INVENTORY 
Contains the in-house labor inventory information (all non-sensitive information 
captured in the resource module regarding labor) 

16 Resources REPORT_MATERIAL_MASTER Contains the list of the material Master codes 
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No. Module FMS View Name Description 

18 System REPORT_USER_TABLE Contains the list of users of the system 

20 System SYSTEM_LOG Contains the list of user logs in the system 
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25 DISPLAYING EXISTING REPORTS 

25.1  Introduction 
In most cases, you will only need to view reports that have already been created. This section describes 
how to display the three types of reports. 

25.2  How to Display a Standard Report 
Each module has its own set of reports. For example, this means that there will be a different set of 
standard reports in the Fleet Management module than in the Resources module. For this tutorial, we will 
display a standard report from the Fleet Management module: 
 

1. Navigate to the Standard Reports window in the Fleet Management module (Fleet Management 
> Reports > Standard Reports). An example of this window is shown below. 

 

The table in this window shows existing reports and notes whether they are available to all 
administrative units. (A checkmark in the Is Public column indicates that a report is available to 
all units.) This table also contains reports entitled "New Report from." These are templates for 
creating new reports from the table indicated in the Table Name column. 

2. Point to the existing report you wish to view, right-click, and then click Show Report. The 
system opens a new browser window and then displays the selected report (using the most 
recent data from the database) in the new window. 
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25.3  How to Display a Graph Report 
For this tutorial, we will display a graph report from the Fleet Management module: 
 

1. Navigate to the Graph Reports window in the Fleet Management module (Fleet Management > 
Reports > Graph Reports). An example of this window is shown below. 

 

The table in this window shows existing reports and notes whether they are available to all 
administrative units. (A checkmark in the Is Public column indicates that a report is available to 
all units.) This table also contains reports entitled "New Report from." These are templates for 
creating new reports from the table indicated in the Table Name column. 

2. Click the Graph tab. The graph is displayed on the Graph tab. 

If you would like to view the data that went into creating the graph, click the Data tab. 

If you would like to print the graph, point to the graph with your mouse, right-click, and then 
click Open in Browser. This displays the graph (and only the graph) in a new window. You may 
then use the familiar browser print command (File > Print) to print the graph. 

25.4  How to Display a Jasper Report 
For this tutorial, we will display a Jasper report from the Fleet Management module: 
 

1. Navigate to the Jasper Reports window in the Fleet Management module (Fleet Management > 
Reports > Jasper Reports). An example of this window is shown below. 
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The table in this window shows existing reports and notes whether they are available to all 
administrative units. (A checkmark in the Is Public column indicates that a report is available to 
all units.) 

2. Point to the existing report you wish to view, right-click, and then click Show Report(HTML), 
Show Report (PDF), or Show Report (Excel). The system opens a new browser window and 
then displays the selected report (using the most recent data from the database) in the new 
window. If some parameters are required, then a pop-up opens window opens and you will need 
to enter the parameter values. 
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26  CREATING NEW REPORTS 

26.1  Introduction 
Reports are based on "views," which are various ways of relating the variables and parameters of the 
AAM database. Some views are more conducive to one type of report than another, and so each type of 
report provides its own list of views. These appear in the Table Name column of each window. 

The first, and most important, task in creating a report is to discover which view best presents the 
information you are seeking to report. Once you know this, you can select the view, manipulate the data 
as desired, and then display the new report. The following sections describe in more detail how you 
create each of the two types of reports – Standard and Graph. 

26.2  How to Create a New Standard Report 
Each module contains its own set of reports. In this tutorial, we will create a new standard report in the 
Fleet Management module. Once you know the view that will serve as the basis of the report, follow 
these steps to create the report: 
 

1. Navigate to the Standard Reports window in the Fleet Management module (Fleet Management 
> Reports > Standard Reports).  

2. In the Table Name column, find the name of the view that will serve as the basis of the report and 
then click the row showing this view. The system highlights the selected row to show that it is 
selected. 
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3. Click the Setup tab. The system displays the tab, which looks like the example below (the actual 
columns listed will differ depending on the selected view). 

 

4. For the list of available columns shown in the Column Label column, select the ones that you 
would like to appear in the report by clicking the checkbox in the Show column for each desired 
column. A checkmark appears in each checkbox to denote that it is selected. 

5. For the selected columns, decide on the order they should appear across the page. The column in 
the top-most row will be listed first (extreme left); the second selected row will be the next 
column (moving rightwards); and so on. To change the order, click on a row to select it and then 
use the green up or down arrows directly to the right of the pane to move it to the desired 
position. 

6. Optionally, select the columns by which the data will be ordered. For example, for a report on 
work orders, you might select Activity and Year as two of the report columns. You could then 
have this report ordered by activity and year by clicking the checkbox in the Order By column for 
each column. When you select a column for ordering, it will appear in the lower pane. 

7. When you select multiple columns for ordering, the lower pane allows you to select which 
column is the primary, which is the secondary, and so on. The column listed first (top-most) is 
the primary order; the next row down is the secondary order; and so on. You may change this 
order by clicking on a row and then using the green up or down arrows directly to the right of 
the pane to move it to the desired position. 
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8. In the lower pane is a column entitled Make Group. This column allows you to optionally 
summarize the column. When you click the checkbox, a new column is added to the upper pane 
to allow you to indicate what mathematical function will be used to summarize the numeric data. 
When an aggregation type is selected, the report will "break" after the last row of the group and 
the aggregation value will be inserted beneath the column. This essentially allows you to insert 
"subtotals" into the report. Note that you do not need to select the Data Aggregation checkbox to 
aggregate data for a group. 

9. In the upper pane, for columns showing numeric data, you may optionally aggregate the data by 
selecting an aggregation function from the drop-down list found in the Data Aggr. Func. column. 
By using an aggregation function, database records are summarized into single instances for each 
non-numeric value (or combination) that is in the report. By default, the numeric values are 
summated to a single value (Total). Note that the Data Aggregation checkbox is automatically 
selected when you select an aggregation function from the drop-down list. 

10. Optionally, you may further summarize numeric data at the end the report. This is accomplished 
by selecting an aggregation function from the drop-down list found in the Total Aggr. Func. 
column. When set to a value other than None, this column inserts a summary value for all records 
at the end of the report beneath the column being summarized. (You do not need to select the 
Data Aggregation checkbox to aggregate the total for a column.) 

11. Optionally, you may restrict the data in the report by using the Filter button. For example, you 
could show particular asset type rather than all asset types by using this button. After clicking the 
button, the system displays the Filter dialog box, which appears similar to the example shown 
below. 
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The left side of the Filter dialog box lists all columns in the view. The right side shows the data 
that is available for the column selected in the left pane. To filter a column, select the checkbox 
that appears next to the name of the column. Then, in the right pane, select the items that you 
would like to appear in the report. 

When you are finished selecting, click OK to close the Filter dialog box.  

12. You have now configured all the parameters for the report. To display the report, click the Show 

Report button. The system opens a new window and displays your report. 

13. Examine the report to see if it displays the information properly. Since the report is in a separate 
window, you may simply click the other browser window (the one showing the Standard 
Reports window) to activate it and then make the desired changes. When you again click the 
Show Report button, the report is updated in its browser window. In this way, you can alternate 
between the two windows to "fine tune" the look of the report. 

14. When the report is as desired, overwrite the text in the Report Name field with the name of the 
report. Then right-click and click Save Report from the shortcut menu that is displayed. 

The report is now created. Note that you may modify a report in a similar way as you create a report. You 
select the report to be modified in the Selection tab and then modify its parameters in the Setup tab. A 
common technique is to display a public report, modify it to suit your own uses, change the report name, 
and then save the report as one of your own reports (using Save Report As Your Own rather than Save 

Report). You may also do this with one of your own, non-public reports. 
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If you wish to print the report, use the browser print command (File > Print). If the report needs further 
formatting before printing, press CTRL+A to select the entire report, press CTRL+C to copy it to the 
clipboard, and then paste it into Microsoft Word. You may then format it as desired using the features of 
Microsoft Word, and then print it. 

26.3  How to Create a New Graph Report 
In this tutorial, we will create a new graph report in the Fleet Management module. Once you know the 
view that will serve as the basis of the report, follow these steps to create the report: 
 

1. Navigate to the Graph Reports window in the Fleet Management module (Fleet Management > 
Reports > Graph Reports).  

2. In the Table Name column, find the name of the view that will serve as the basis of the report and 
then click the row showing this view. The system highlights the selected row to show that it is 
selected. 

3. Click the Setup tab. The system displays the Setup tab, which appears similar to the following. 

 

4. In the Graph Type column, click the arrow to display the drop-down list and then click the type 
of graph you want to use. The following graph types are available: 

• General – This graph type plots any X-axis variable against a user-defined summarization 
of a Y-axis value. This graph differs from the other graph types in that you can define 
how the Y axis is summarized. 

• Conditional – This graph type displays values only if the values pass a specified criterion. 

• Distribution – This graph type shows summarized values of one variable plotted against 
another variable. It is usually displayed as a bar chart. 

• Cumulative – This type of graph is utilized for building frequency or probability density, 
or cumulative probability density functions, for selected variables. 

• Weighted Average – This type of graph plots any X-axis variable against a weighted 
average of a Y-axis value. This graph is similar to the General type of graph, with two 
exceptions:  (1) the aggregation function is always "average"; and (2) it is a weighted 
average, not a simple average, and so needs a "weighting" variable. 

When you select a graph type, the system modifies the columns in the table to support the type of 
graph selected. 
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5. Complete the remaining columns in the table as appropriate. 

6. Optionally, you may restrict the data in the report by using the Filter button. For example, you 
could show particular asset type rather than all asset types by using this button. After clicking the 
button, the system displays the Filter dialog box, which appears similar to the example shown 
below. 

 

The left side of the Filter dialog box lists all columns in the view. The right side shows the data 
that is available for the column selected in the left pane. To filter a column, select the checkbox 
that appears next to the name of the column. Then, in the right pane, select the items that you 
would like to appear in the report. 

When you are finished selecting, click OK to close the Filter dialog box.  

7. You have now configured all the parameters for the graph. To display the graph, click the Graph 
tab. The system opens a new window and displays the graph. 
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8. If you wish to modify the appearance of the graph, right-click on the graph and then click 
Change Graph Report Properties. The system displays a dialog box similar to the following, 
which you use to modify the appearance of the graph. 
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9. Make the desired changes and then click OK. The system closes the dialog box and re-draws the 
map utilizing the new parameters you specified.  

10. If you wish to print the graph, right-click on the graph and then click Open in Browser. The 
system displays the graph (and only the graph) in a new window. You may then use the 
browser's print command (File > Print) to print the graph.  

11. If you wish to save the graph, click the Setup tab. Then point to the tab, right-click, and then click 
Save Report from the shortcut menu. (Note that the name assigned to the report when you save 
is the type of graph. If you wish to change this, click the Selection tab, find the report, highlight 
the default name of the report, and type the desired name. When you close the window, the 
system will ask if you wish to save the new name.) 

Note that you may modify a report in a similar way as you create a report. You select the report to be 
modified in the Selection tab and then modify its parameters in the Setup tab. A common technique is to 
display a public report, modify it to suit your own uses, change the report name, and then save the report 
as one of your own reports (using Save Report As Your Own rather than Save Report). You may also 
do this with one of your own, non-public reports. 
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27  EXPORTING DATA 

The data shown in Standard and Graph reports may be exported to an external file. You may also use 
similar techniques to export data from tables shown in windows and panes. This section describes how to 
save data from a report or window to a separate file. 

To prepare for exporting data, you need to display a data table in its own window. The means for doing 
this are described below: 

 Standard reports — standard reports are already displayed in a separate browser window, so 
no preparation beyond displaying the report is needed. 

 Graph reports — select the desired graph in the Selection tab and then click the Data tab to 
display the data table that underlies the graph. Then point to the table, right-click, and click 
Open in Browser. This command displays the graph data in a new window, and it is now 
ready to be exported. 

 Data in a table in a window or pane — after displaying the window that shows the desired data 
table, point to the table, right-click, and select Export Data. This command displays a new pop-
up window that let you do 3 method of exporting data. These 3 methods are described below. 

27.1  How to Export Data in Various Format 
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1. Open any window containing data in a grid or from view. 

2. Right-click anywhere in this window and select Export Data. A new pop-up window opens as 
shown below. 

 
3. In the columns pane, select all the columns you want to export (by default, all the columns are 

selected) by clicking on the columns you want (hold CTRL for multiple selection, or select the 
first one and hold SHIFT and click on the last one to select successive columns). 

4. In the Rows pane, select what you want to export: 

• If you want to export all the data in the pane, select All. 

• If you want to export only the current page of data, select Current Pane. 

• If you want to select a range of rows, select Rows and precise the From and To values. 

5. Select your output format (Excel, Comma Separated or HTML). 

6. Click on OK. 
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28  MANAGE BATCH FILES 

In the Import Runner window, you can manage your batch files. You can create folders, upload and 
delete files at your convenience. Once your batch files have been uploaded, you can then process them. 

28.1  How to Create a New Directory in Your 

Folder 
 

1. Open the Import Runner window (System > Tools > Import Runner). 

 
2. In the first tab “Imports”, click once on any of the records. The system highlights the record. 
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3. Click on the third tab “Import Log”. In this tab you will see all the imports that your agency has 
run previously. 

 

4. Right-click and select Manage Files. A pop-up window opens. 
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5. In the pop-up window, you see the root of your agency folder (other agencies cannot see these 
files). To create a new directory in your agency’s folder, right-click and then select Make 
Directory.  

 
6. A dialog box opens. Type in the name of the directory you want to create. When finished, click on 

OK. The new directory is created and appears in the pop-up window with a icon . To open this 
folder, click on the underlined folder name. 

 

 

28.2  How to Upload a file in a folder 
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1. Open the Import Runner window (System > Tools > Import Runner). 

 
2. In the first tab “Imports”, click once on any of the records. The system highlights the record. 

3. Click on the third tab “Import Log”. In this tab you will see all the imports that your agency has 
run previously. 

 
4. Right-click and select Manage Files. A pop-up window opens. 

5. In the pop-up window, you see the root of your agency folder (other agencies cannot see these 
files). Open the folder in which you wish to upload the file into by clicking on the underlined 

folder name (folders are indicated by the  icon). 

6. Once in the appropriate folder, right-click and then select Upload File. A new dialog box open. 
Click on Browse to open a MS Windows browsing window. Find the file you wish to upload to 
the server. Click on OK in the MS browser.  
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7. The path of the file is displayed in the pop-up window. Click on Upload. Your file is transferred 
to the server and appears in the list of files in the folder. 

 

28.3  How to delete a file or a folder: 

 
1. Open the Import Runner window (System > Tools > Import Runner). 

 
2. In the first tab “Imports”, click once on any of the records. The system highlights the record. 

3. Click on the third tab “Import Log”. In this tab you will see all the imports that your agency has 
run previously. 

 
4. Right-click and select Manage Files. A pop-up window opens. 



 AgileAssets Fleet Management System 
 Tutorial 

Proprietary and Confidential © 2008 AgileAssets, Inc. Page 105 

5. In the pop-up window, you see the root of your agency folder (other agencies cannot see these 
files). Open the folder from which you wish to delete the file by clicking on the underlined folder 

name (folders are indicated by the  icon). Once in the appropriate folder, check the box in front 
of the file(s) would like to delete. Right-click and then select Delete Selected. The file(s) is deleted 
from the server. You can also delete folders if there are no files contained in them. 
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29  IMPORTING DATA 

This window contains all the batch types that can be used to batch data in. Some batch types can be used 
by most agencies, whereas others can only be used by specific agencies. The CPA’s system administrator 
maintains a list of all batching agencies and which types are appropriate. Users should only use batch 
types appropriate for their agency. The following examples are generic and will apply to all batch types. 

The Equipment Purchase batch type should only be used by agencies indicated as Inventory Batching. 
The list of Inventory Batching agencies is maintained by CPA’s system administrator. 

 

29.1  How to Import a Batch File  
Follow these steps: 
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1. Open the Import Runner window. 

 
2. In the first tab “Imports”, click once on the batch type desired. The system highlights the record. 

3. If you want to review the source file (your file) column layout, click on the second tab “Import 
Details”. The left pane shows the Import columns with the column order (Order). The right pane 
shows how the data from the source file is mapped to the target table. 
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4. Click on the third tab “Import Log”. In this tab you will see all the imports that your agency has 
run previously. 

 

5. To batch in a new file, right-click and select Import New Data (this step assumes that your file 
has already been uploaded to the server and is ready for processing – if your file hasn’t been 
uploaded yet, refer the Manage Batch Files section). A pop-up window opens. 

 
6. In the pop-up window, you see the root of your agency folder (other agencies cannot see these 

files). Navigate to the file you want to process. Select this file by checking the box in front of that 
file. Once selected, click on OK.  

 
7. The file is then process in real time and a window display the progress status. 
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8. Once completed, click on OK in the pop-up window.  

 
9. If some errors (validation) occurred during processing, the system will prompt you to download 

the corresponding error file. In the dialog box, click on Yes to download the file on your local 
computer (the output file is the same as the input file, with 2 additional columns for 
RECORD_NUM and ERROR DESC). 

 
10. In the system, a new row appears in the Import Log tab showing the summary for this batch. 

 

29.2  How to Correct Errors 
1. If your batch had some errors, open the downloaded the error log file from your local computer.  

2. Review the message in the Error column for each record. Make the necessary corrections to this 
error file. Once corrected, delete the 2 extra columns RECORD_NUM and ERROR DESC and save 
this file. 

3. Upload this corrected file to the server (see the Manage Batch Files section) and re-import the file. 

4. Repeat this process until all the errors have been corrected. 
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30  HOW TO SEEK HELP 

Every effort is made to ensure that you can successfully use FMS to efficiently perform the tasks of your 
job. Yet, at times, questions may arise about particular features or how to perform certain tasks. FMS 
includes a comprehensive Help system. This system contains information on all features of the system 
and provides instructions on using many features of the system. To access the Help system, click the help 

icon  on the far left side of your browser window. 
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